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LAB 1. READING LANDSCAPES FROM
SATELLITE IMAGERY

Introduction

In this lab, you will practice using various tools in Google Earth to prepare you for the upcoming labs in the
course. You will use the historical imagery tool to observe changes over time, take various distance and area
measurements, the path tool and explore the surface of the moon and Mars. You will also practice exporting
properly referenced maps from Google Earth.

To get started, ensure you have downloaded Google Earth Pro for desktop on your computer. This software
is free for download from here:

https://www.google.com/earth/versions/#earthpro

Please note that although there is an online version of Google Earth, not all tools are available on the online
platform. Download and open the Lab1.mkz file that contains markers for all the locations we will be visiting
in this lab.

Make sure that the “Terrain” layer is selected as you

¥ Lavers
complete the labs in this course, as it will allow youtosee  + @ Primary Database

the Earth’s surface in 3D. For optimal viewing of B Announcements
BV
landscapes with the least things in the way, we suggest you g;arders and Labels
3l Flaces
disable the Places, Roads, 3D Buildings, Weather, Gallery b B Photos
and More layers. The Photos layer can sometimes be v 5 Roads
. . » 3D Buildings
useful for gathering on-the-ground confirmation of what . % Weather
a location looks like. » | I Gallery
You can change the vertical exaggeration value of the d [ mare
¥ Terraln

3D terrain. This exaggeration (set between 0.01 and 3)
indicates by what factor vertical distances are exaggerated.
For example, if set to 3, then vertical distances will appear 3x bigger than in real life. This can allow you to see
more details, but can also cause some distortion. You can play with changing the vertical exaggeration when
exploring landscapes to get a better view:
On a PC: Tools > Options > 3D View from the Tools figure
On a Mac: Google Earth > Preferences > 3D View



https://www.google.com/earth/versions/#earthpro
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Tasks

1) Coordinate Formats (5 pts)

You can change the format coordinates are displayed in:
On a PC: Tools > Options > 3D View > Show lat/long
On a Mac: Google Earth > Preferences > 3D View > Show Lat/Long

You can read the coordinates of your curser as you move around the map off the bottom banner (Figure 1).

Imagery Date: 11/6/2004 17 T 587908!99 mE 479097570 m/N' elev. 99m  eyealt 496 m

Figure 1. Example of bottom banner showing exact imagery date, coordinate, and eye altitude in Google Earth.
Fly to the Ron Joyce Field marker. Report the coordinates of the centre of the field using all the coordinate

formats available in Google Earth.

2) Historical Imagery (7 pts)

The historical imagery tool can be accessed from the top tool bar:

.:w-=m S+ - — e — i — - —= : -
VR || |9 | & |® ii:| @, | E X & B (E| e

Figure 2. Tool banner located at the top of the Google Earth screen with the historical imagery tool highlighted.

Once opened, you can scroll between images taken on different dates. Although the tool bar shows only the
moth and year, the bar at the bottom of the window shows the exact imagery date in mm/dd/yyyy.

Scroll back in time to see how this part of campus has changed since the earliest imagery available from 1985.

a) Using the historical imagery tool determine between which dates the Ron Joyce Stadium was

constructed

b) What was in this location before the stadium?

c) Look up the year the stadium was opened

d) Look at the Peter George Centre located next to the Ron Joyce Stadium.
Using the historical imagery tool, estimate when construction of the building began and
finished

e) What was located here in 2005?
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3) Measurements!(11 pts)

The measurement tool can be accessed from the top tool bar:

0O oo @& @] =xa n[=e

Figure 3. Tool banner located at the top of the Google Earth screen with the measurement tool highlighted.
The measurement tool allows you to measure various distances by toggling between the Line, Path, Polygon
and Circle options, respectively.

a) Fly to the Ron Joyce stadium and measure the following its width and length between the
goal posts in metres and yards.

b) Fly to the Parking Lot M marker. Use the path measurement tool to measure the distance between
the parking lot marker and the GO bus stop on campus along the sidewalk (the path you would walk)
in kilometres . Now measure the distance between the parking lot P marker and the GO bug stop
in kilometres

c¢) Use the polygon measurement tool to measure the perimeter and area of Burke
Sciences Building in metres and metres squared.

d) Fly to the Mary Keyes roundabout marker on campus. Use the circle measurement tool to measure
the radius of the inner edge of the road and the outer edge of the road of the roundabout.

Use these values to calculate the width of the road around the roundabout

4) Path Tool (10 pts)

The path tool can be accessed from the top tool bar:

Figure 4. Tool banner located at the top of the Google Earth screen with the path tool highlighted.
The path tool allows you to create a permanent path layer on the map that can then be used to do additional
measurements. In this lab, we will use the path tool to explore vertical profiles of paths.

a) Fly to the Parking Lot M marker. Use the path measurement tool to measure the distance between
the parking lot marker and the GO bus stop on campus along the sidewalk (the path you would
walk) in kilometres . You will be able to see the path length once you create the path under the
“Measurements” tab. Compare your answer to the distance you measured in question 3b and comment
on why there are any discrepancies

b) Once you have created the path, you can see its vertical profile by right clicking on it and selecting
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“View elevation profile”. Using the figure that comes up, indicate whether lot M or the GO Bus stop is
at a higher elevation . Record the elevation at each of these two markers

c) What are these elevations relative to?

d) Calculate the average slope between the Lot M and Go Bus stop markers using the elevation profile
figure. Show all your work

Remember the equation for slope:

QOO = OHOOOO OO OOOOOOO (AD) = DhOOOO OO
hOOOOOOOO (AD)

5) Exploring Other Worlds (5 pts)

You can toggle between exploring the Earth’s surface and that of other planetary bodies:

ﬁ _117+ l_ﬁi+ !j:i E+ v+ 1:; @ h Q;‘ D - é @ -‘_ﬁ'f'_- t

Figure 4. Tool banner located at the top of the Google Earth screen with the menu to toggle between views
highlighted.

a) Switch to Mars view and fly to the Olympus Mons and read the information card located there.
What makes this location special on the surface of Mars?

b) Fly to the Olympica Fossae marker and observe the strange patterns on the planet’s surface.
Speculate on what might have created these features and explain your reasoning
Hint: Think about how similar features are created on Earth’s surface.

¢) Switch to the Moon view and fly to the Apollo 13 Landing Site. What are the two named craters

near the site called?

6) Exporting Maps (7 pts)

Return to Earth view. You will export a proper map of McMaster University campus. You can export maps as

images with all the proper annotations using the Save Image tool:

Figure S. Tool banner located at the top of the Google Earth screen with the save image tool highlighted in red.
The create marker tool is bighlighted in green.

Choose a building or location on campus that we have not previously explored in this lab (i.e., do NOT
choose the Ron Joyce stadium, PGCLL, Parking lot M or P, the GO bus stop, or the Burke Science building).

Create a marker at this building using the create marker tool and label it appropriately with the building name.
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Make sure all other labels and markers are unchecked, so that only your building is labelled. Export your map
to create a properly exported Google Earth map of campus with your chosen building labelled and attach it to
your report . Make sure you choose a scale where the entirety of campus is visible (not just your building).

Your map should include:

* A descriptive title

* A north arrow

* NO legend

e Ascale bar

* The Google logo (for referencing purposes)

* One building on campus labelled as a marker (no other labels should be present on the map)

Hint: You can toggle which elements are visible from the Map Options menu.
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LAB 2: KARST AND HILLSLOPE PROCESSES
AND LANDFORMS

Introduction

In this lab, you will explore karst and hillslope processes using Google Earth. You will also perform stability
calculations for a single rock and for a slope. To get started, download the associated Lab2.kmz file from
Avenue to Learn and open it in Google Earth. You should see all the stops associated with this lab.

There are four locations that will be explored in this lab: the Malham Cove in the UK, Maungati in New
Zealand, the Hattian Landslide in Pakistan, and the Oso Landslide in the USA. You will be asked to identify
different types of landscapes and landforms, look at historical imagery of mass wasting events, and perform

some calculations using tools available in Google Earth.

Tasks

1) Malham Cove, UK (4 pts)

Fly to the Malham Cove stop and explore the peculiar landscape observed here. You can also look at photos
taken by visitors on the ground to get a better idea of the surface. Identify the landform seen here and

briefly explain how the peculiar landscape forms

2) Maungati, New Zealand (4 pts)

Fly to the Maungati stop and explore the peculiar land features observed here. Identify what the features are
. Knowing that the underlying geology of the area is comprised of limestone, briefly speculate on the most

likely explanation for their formation
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3) Stability Calculations (7 pts)

a) Consider a 8 kg boulder sitting on a 14° slope. Determine whether the boulder will move by
calculating the stability factor (F). Be careful of units!

b) Now consider the same slope is covered with a 3 m thick layer of loose material over a solid sliding
plane. The water table is 0.7 times this thickness (&) and laboratory analysis has shown that the material
has a cohesion of 5 kN/m2, a unit specific weight of 12 kN/m3, and an angle of repose of 8°. Assume
that the specific weight of water is 9.8 kN/m3. Determine whether the boulder will move by calculating
the stability factor (F). Be careful of units!

4) Hattian Bala Landslide, Pakistan (8 pts)

a) Fly to Hattian Bala stop and observe the most recent satellite imagery (2021). What evidence of a
previous mass wasting event can you identify?
b) Use the historical imagery tool to compare the current landscape with the landscape in 2002,

before the mass wasting event. Explain the formation of the Zalzal Lake.

c) Using the path tool, calculate the average slope of the landslide debris from the most recent satellite
imagery (show all your work).
d) Fly to the Hattian Bala stop 2. Compare the imagery from 2002 and 2010 in this location. Describe

the differences you see and explain why they occurred.

5) Oso Landslide, USA (22 pts)

a) Fly to the Oso Landslide stop. Using the time historical imagery tool, can you guess a timeframe
of when the landslide(s) occurred? Note that there may be more than one that occurred since
satellite imagery was available.

b) Confirm the exact date of the most recent (and largest) Oso Landslide by researching the event. On
what exact date did this event occur?

c) Using the most recent satellite imagery following the slide and comparing it to imagery both
before and after, describe the effects of the most recent slide on the Steelhead River both upstream and
downstream.

d) Look at the forested area surrounding the slide over the years. Can you identify a human activity

that may have contributed to the slide? Explain how this activity influences hillslope processes.

e) Historical weather data indicates that prior to the most recent slide, the Oso area had heavy rainfall



10 | LAB 2: KARST AND HILLSLOPE PROCESSES AND LANDFORMS

during the previous 45 days that was 200% percent of normal. Explain how this may have contributed
to the event.

f) A Seattle Times article published following the event included the following:

SJobn Pennington, Director of Snobomish County’s Department of Emergency Management,
stated..., “This was a completely unforeseen slide. This came out of nowhere.”” (Armstrong, Carter &
Baker, 2014)

From what you’ve seen in this lab and any additional research, do you agree with this statement or
were there warning sign that such an event may occur in this area? Be sure to properly cite any outside
sources.

g) Using the path tool, calculate the average slope of the landslide debris from the most recent satellite

imagery. Show all your work. Explain why it may be different that of the Hattian Bala landslide.

h) Using figure from the Arizona Geological Survey (on the next page) and other information you
have learned about the Oso Landslide, what type of mass wasting event would you classify this as? You

can have more than one answer, as long as you justify it with your observations.

Extra resources to help you:
This interactive map by the Seattle Times shows the history of mass wasting events in the area.

This video, published by the US Geological Survey, shows the results of a simulation of the Oso
Landslide. Observe how remarkably quickly the slide took place.

References:

Armstrong, K., Carter, M., & Baker, M. (2014, March 24). Risk of slide ‘unforeseen’? Warnings go

back decades. Seattle Times. https://special.seattletimes.com/o/html/localnews/
2023218573 _mudslidewarningsxml.html


https://special.seattletimes.com/o/html/localnews/2023218573_mudslidewarningsxml.html
https://projects.seattletimes.com/2014/building-toward-disaster/
https://www.youtube.com/watch?v=2NzHCOhKr7g
https://special.seattletimes.com/o/html/localnews/2023218573_mudslidewarningsxml.html
https://special.seattletimes.com/o/html/localnews/2023218573_mudslidewarningsxml.html
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LAB 3: FLUVIAL PROCESSES AND
LANDFORMS

Introduction

In this lab, you will explore various fluvial processes and landforms on Google Earth. To get started, download
the associated Lab3.kmz file from Avenue to Learn and open it in Google Earth. You should see all the stops

associated with this lab.

There are four locations that will be explored in this lab: the upper Columbia River in British Columbia, the
Tagliamento in Italy, rivers in Egypt, and the Purus River in Brazil. You will be asked to identify river patterns,
specific landforms, and perform some calculations using tools available in Google Earth. The final question

allows you to independently explore rivers and identify fluvial features on the Earth’s surface.

Tasks

1) Columbia River, British Columbia (4 pts)

a) Fly to the Columbia River marker. What type of river pattern is seen at this stop?

b) Describe the conditions that favour the development of this river planform?

2) The Tagliamento, Italy (17 pts)

a) Fly to the Tagliamento Stop 1. What type of river pattern is seen at this stop?
b) Describe the four conditions that are required to have the river planform identified at Stop 1
and comment on the primary sediment source for this river?
c) Fly to the Tagliamento Stop 2. What type of river pattern is seen at this stop?
d) Identify the depositional feature seen at Stop 2. Briefly describe the processes that lead to its
formation
e) Turn on the Borders and Labels layer and notice the Friuli-Venezia Giulia border line. Comment

on how the border line location matches river path and discuss the origin of any discrepancies.



12 | LAB 3 FLUVIAL PROCESSES AND LANDFORMS

f) Fly to the Tagliamento Stop 3. What type of fluvial feature is seen here? Briefly describe how

this feature formed.

3) Egypt (7 pts)

a) Fly to the Egypt Stop 1. Observe the drainage pattern visible at this stop. What type of hydrologic
regime would you expect these rivers to have given their geographic location?

b) Fly to the Egypt Stop 2. Name this culturally and historically important river and identify
its base level

c¢) What type of hydrologic regime is this river?

d) Explore the hydrologic origin of this river and explain why the answer to (c) is different than that
of (a) even though the rivers in Stop 1 feed into the river at Stop 2.

e) Fly to the Egypt Stop 3. Identify the landform at this stop

4) Purus River, Brazil (12 pts)

a) Fly to the Puris River Stop 1. What fluvial feature is seen here? Briefly describe how this feature
formed.

b) Calculate the channel sinuosity of the Purus River between Stop 2 and Stop 3. Show all your work.

c) Calculate the average meander wavelength of the Purus River between Stop 2 and Stop 3. Show all
your work.
d) Calculate the average radius of curvature of bends along the Purus River between Stop 2 and Stop

3. Show all your work.

5) Find a Landscape Example (5 pts)

Explore Google Earth on your own and find an example of a fluvial landform located on a continent not
already explored in this lab (i.e., outside North America, South America, Europe, and Africa). Identify
the landform and briefly explain its formation. Include a properly formatted image with

your answer.
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LAB 4: GLACIAL AND PERIGLACIAL
PROCESSES AND LANDFORMS

Introduction

This lab explores various glacial processes and landforms on Google Earth. To get started, download the
associated Lab4.kmz file from Avenue to Learn and open it in Google Earth. You should see all the stops

associated with this lab.

There are four locations that will be explored in this lab: glaciers in the Alpes of Switzerland, the Columbia
Glacier in Alaska, the Vatnajokull glacier in Iceland, the Mackenzie River Delta in the Northwest Territories,
and the Drakensberg area in Lesotho. You will be asked to identify various glacial and periglacial landscapes
and perform some calculations using tools available in Google Earth. The final question allows you to

independently explore the globe and identify glacial and periglacial features on the Earth’s surface.

Tasks

1) The Alpes, Switzerland (6 pts)

a) Fly to the Alpes marker and notice the five markers labelled A-E in this area. Identify the features at
each marker.

b) Are these features erosional or depositional?

2) Columbia Glacier, Alaska (13 pts)

a) Fly to the Columbia Glacier marker and explore the area. What is the dark streak through the middle
of the glacier?

b) Explore the edge of the glacier where it meets the sea. What is the name of the process that is seen
to be taking place here?

¢) Measure the length of the glacier from Marker A to its edge in the most recent imagery in 2021.
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d) Use the historical imagery tool to observe changes in the glacier over time. Measure the length of
the glacier from Marker A to its edge in 2003 and in 1984
e) Use the measurements from (c) and (d) to calculate the rate of retreat between 1984 and 2003
and between 2003 and 2021 . Show your work.
f) Assuming the Columbia Glacier continues to retreat at the current rate (the rate calculated between
2003-2021), in how many years will it be completely retreated to Marker A? Show all your work.
g) Assuming the Columbia Glacier completely melts in the future, what type of landform will be

present here?

3) Vatnajokull, Iceland (12 pts)

a) Fly to the Vatnajokull Stop 1. What landform is located here?

b) Is the glacier actively melting or accumulating at the time of the imagery? How can you tell?

c) Notice the crescent shape feature at Marker A that approximately follows the shape of the glacier’s
edge. What type of moraine is this?

d) Briefly describe how this moraine formed and what type of material do we expect to find
here?

e) Fly to the Vatnajokull Stop 2. What are these elevated ridges called?

f) Briefly describe how these features form

g) Zoom out and explore the area around the Vatnajokull Stop 2. Identify two types of lakes present

in this area.

4) Mackenzie River Delta, Northwest Territories (6 pts)

a) Fly to the Mackenzie River Delta Stop 1. What landforms are seen here?
b) Briefly describe how these features form.
c) Fly to the Mackenzie River Delta Stop 2. What landform is seen here?
d) Briefly describe how this feature formed.

5) Drakensberg, Lesotho (3 pts)

a) Fly to the Drakensberg marker and observe the unique features visible on the side of the mountain.

Briefly explain the process that leads to these features and what it is called
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6) Find a Landscape Example (5 pts)
Explore Google Earth on your own and find an example of a glacial or periglacial landform located in a

country not already explored in this lab. Identify the landform and briefly explain its formation

. Include a properly formatted image with your answer.
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LAB 5.1: FLUVIAL SYSTEM VISIT

Introduction

This lab will have you visit a real-life fluvial system! With your tutorial group, you will be visiting Coldwater
Creek in West Campus, which is located by Parking Lots M and P. Please meet your TA at the shuttle bus
stop by Lot M (see map below) at the schedule time for your lab. If you anticipate needing extra time to get
to this location, please let the TA know ahead of time. You are responsible for having everything you
need: weather appropriate clothing, closed toe footwear, pen/pencil, notebook, and something to
take photos (phone, camera). Rainboots/waders are not necessary, but please bring them if you have them

available as they may be helpful.

r

o= |
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Figure 1. Map of meeting location for Lab S bighlighted in the red and orange star.
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In addition to the site visit, you will be asked to compute basic hydraulic and sediment transport calculations

on Coldwater Creek based on existing measurements that will be provided to you.

Tasks

1) Site Visit (25 pts)

Choose a sub-reach of Coldwater Creek approximately 100 m in length. This will be your study reach.

a) Sketch out a planform map of your study reach roughly to scale . Your sketch should include

the following:

> Both banks of the channel

> The flow direction

° Infrastructure present (e.g., bridge, roads, parking lot, culvert etc.) with appropriate labels
° Any prominent vegetation (e.g., large trees, grass patches, large wood in the channel)

o Labels for the channel and floodplain

b) Sketch out an average cross-section of your study reach roughly to scale . Your sketch should

include the following:

> Both banks and the bed of the channel

° The floodplain

> The flow direction

° Infrastructure present (e.g., bridge, roads, parking lot, culvert etc.) with appropriate labels
°Any prominent vegetation (e.g., large trees, grass patches, large wood in the channel)

° The current water surface elevation

c) Provide appropriately labelled photos of your study reach showing the following features. Photos
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should include something to establish scale and always indicate the flow direction (either with an arrow

or in the figure caption)

° The planform (this may require more than one photo)
° Channel cross-section,
> Any additional photos of gynomorphically interesting features (e.g., large wood, infrastructure,

bedforms like bars)

d) Based on your observations and using your field photos as evidence, comment on the following

° The planform pattern of Coldwater Creek
° The channel morphology of Coldwater Creek and presence of any bedforms

° The dominant sediment size present in Coldwater Creek

2) Hydraulic and Sediment Transport Calculations (20 pts)

A group of students came out to Coldwater Creek during a flood and took measurements of the channel slope,
cross-section, and sediment size. A set of velocity measurements were also taken at the centre of the channel.

The data they collected is provided below (be aware of the units!). Using this data,

a) Calculate the hydraulic radius (Hint: You can assume the cross-section is approximately rectangular)
b) Calculate the mean flow velocity using two methods:

1. The flow measurements

2. The Manning equation.
For this exercise, you may choose to estimate the Manning’s n coefficient from a table (be
sure to justify your choice) or from the empirical equation based on the median sediment

diameter. Be sure to list which method you used.

c) Calculate the discharge
d) Determine whether the flow is laminar or turbulent
¢) Determine whether the flow is subcritical or supercritical

f) Determine whether the median sediment size will move under these flow conditions

Channel slope: 0.00426
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Median sediment diameter: 2 mm

Cross-section survey:

Flow VCIOCity measurements:
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LAB 5.2: FLUVIAL SYSTEM ANALYSIS

Introduction

This lab will have you examine a fluvial system on McMaster’s campus: Coldwater Creek in West Campus,
which is located by Parking Lots M and P. You will be asked to perform some basic calculations of the channel
planform, and interpret human impacts on the creek. In addition, you will be asked to compute basic hydraulic
and sediment transport calculations on Coldwater Creek based on existing measurements that will be provided

to you.

Tasks

1) Site Analysis (25 pts)

To get started, download the associated Lab5.kmz file from Avenue to Learn and open it in Google Earth. You

should see a stop indicating the location of Coldwater Creek in West Campus.

a) Investigate the area surrounding Coldwater Creek. Describe what human activities likely impact the

geomorphology of this river
b) Would you interpret the current river path as the original path, or has it been modified? Provide a

justification for you answer

Choose a sub-reach of Coldwater Creek approximately 100 m in length between Osler Dr. and its downstream
end where it joins with Spencer Creek. This will be your study reach. Remember you can use the historical

imagery tool to find imagery with the best view of the creek.

c) Create a labelled map of your study reach . You can export your map as an image and edit it
in another program (Word, PowerPoint, Adobe) to add labels and arrows. Your map should include the

following:
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° The upstream and downstream end of your study reach

> The flow direction with a labelled arrow

o Any major Infrastructure present (e.g., bridges, roads, parking lots, etc.) with appropriate
labels

> A north arrow

> A scale bar

d) From the upstream to downstream end of your study reach, measure the reach length (Hint: reach
length is calculated along the channel centerline) , and calculate the channel sinuosity
Show your work.

f) Indicate on your map (with an arrow, line, or polygon), where you interpret the river floodplain to

extend based on clues in the landscape . What type of flood hazards do you foresee in this area?

2) Hydraulic and Sediment Transport Calculations (20 pts)

A group of students came out to Coldwater Creek during a flood and took measurements of the channel slope,
cross-section, and sediment size. A set of velocity measurements were also taken at the centre of the channel.

The data they collected is provided below (be aware of the units!). Using this data,

a) Calculate the hydraulic radius (Hint: You can assume the cross-section is approximately rectangular)
b) Calculate the mean flow velocity using two methods:

1. The flow measurements

2. The Manning equation.
For this exercise, you may choose to estimate the Manning’s n coefficient from a table (be
sure to justify your choice) or from the empirical equation based on the median sediment

diameter. Be sure to list which method you used.

c) Calculate the discharge
d) Determine whether the flow is laminar or turbulent
e) Determine whether the flow is subcritical or supercritical

f) Determine whether the median sediment size will move under these flow conditions
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Channel slope: 0.00426
Median sediment diameter: 2 mm

Cross-section survey:

Flow VCIOCity measurements:
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LAB 6: COASTAL AND AEOLIAN PROCESSES
AND LANDFORMS

Introduction

This lab focuses on coastal and aeolian processes and landforms and you will visit many different spots around
the Earth and even one on Mars on Google Earth! To get started, download the associated Lab6.kmz file from

Avenue to Learn and open it in Google Earth. You should see all the stops associated with this lab.

There are seven locations that will be explored in this lab: the islands of French Polynesia, the west coast of
Panama, Prince Edward Island, the Namib Desert in Namibia, the Rub’ al Khali Desert in Saudi Arabia, and
two dune fields on Mars. You will be asked to identify different types of landscapes and landforms, look at
historical imagery of coastal sediment transport, and analyze wind patterns. The final question allows you to

independently explore landscapes and identify coastal or aeolian features on the Earth’s surface.

Tasks

1) French Polynesia (6 pts)

Fly to the French Polynesia stop and explore the array of different islands located around the placemark.

Compare the islands of Maupiti and Tapai in more detail.

a) Briefly describe how the unique morphology of these two islands was formed

b) Which island would you hypothesize is younger and briefly explain how you know

2) West coast of Panama (10 pts)

a) Fly to Panama stop 1. Which river discharges into this bay?
b) Identify the type of land feature is stop 1 and briefly describe its physical characteristics
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c) Fly to Panama stop 2 and notice the three markers labelled A, B, and C in this area. Identify each

feature and indicate whether it is an erosional or depositional feature

3) Prince Edward Island, Canada (10 pts)

a) Fly to PEI stop 1. Identify this feature.

b) Briefly describe how the feature at stop 1 formed.

c) Fly to PEI stop 2. Identify the feature.

d) Take time to explore this feature. Use the historical imagery tool to look at the evolution of this
feature between 2010 and 2021. In what direction is the longshore current? Give your answer in cardinal
directions (N, S, E, W).

e) Fly to PEI stop 3 and notice the three markers labelled A, B, and C in this area. Identify each
feature.

f) What evidence fo you see for the direction of sediment transport through location B?

4) Namib Desert, Namibia (5 pts)

a) Fly to the Namib Desert stop 1. Identify the type of dunes seen here.
b) What do the dunes at stop 1 suggest about the dominant wind direction in this area? Give your
answer in cardinal directions (N, S, E, W).
Note that more than one type of dune or answer may be correct here as long as you justify your
answer with your observations.
c) Fly to the Namib Desert stop 2. Identify the type of dunes seen here

d) What do the dunes at stop 2 suggest about the dominant wind direction in this area?

5) Rub’ al Khali Desert, Saudi Arabia (5 pts)

a) Fly the Rub’ al Khali Desert stop and identify the type of dunes seen here.
b) Given the orientation of the dunes, what is the dominant wind direction in this area? Give your
answer in cardinal directions (N, S, E, W).

c) Briefly describe how these types of dunes form.
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6) Dunes on Mars (4 pts)
a) Switch the Mars view and fly to the Nili Patera stop. What type of dunes are seen here?

b) How do they compare to dunes seen in the Rub’ al Khali Desert?
c) Fly to the Eldorado, Mars stop. What type of dunes are seen here?

7) Find a Landscape Example (5 pts)

Explore Google Earth on your own and find an example of a coastal or aeolian landform located in a country
not already explored in this lab. Identify the landform and briefly explain its formation . Include

a properly formatted image with your answer
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PART I

LABS ARCHIVED (RESTRICTED
ACCESS)

This section is restricted for instructor use only. (Includes unreleased labs and answer keys for TAs)
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